
Professional Photographic Tools

Quick Start Guide



The Complete Collection provides the most powerful and intuitive solutions to digital photogra-

phers’ workflows. From capture to print, the Complete Collection brings award-winning plug-ins 

for Adobe® Photoshop® and Apple® Aperture™ together to create exciting photographic results 

while saving time. Dfine, Viveza, Color Efex Pro, Silver Efex Pro, and Sharpener Pro feature 

Nik Software’s U Point® technology, giving photographers the most powerful tools for precise 

and natural photographic enhancements and corrections without the need for complicated 

selections or layer masks.
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Dfine 2.0 Viveza Color Efex Pro 3.0

Installation

4 Silver Efex Pro Sharpener Pro 3.0 5

Windows
1. Close all open applications. 

2. Insert the Complete Collection CD.

3. When the auto-run installer appears, choose the plug-in to install.  

4. The installer will appear, review the Read me, accept the License Agreement, and review 
the suggested installation location. For example, the appropriate location for Adobe Photo-
shop CS3 is: 

C:\Program Files\Adobe\Adobe Photoshop CS3\Plug-Ins*

5. Specify whether the Nik Selective Tool launches automatically when you start Photoshop. 
Please see the User Guide for the selected plug-in for more information. 

6. When the installation is complete, click the Finish button to close the plug-in installer and 
return to the Complete Collection installer to choose another plug-in to install. 

*If you are using an image editing application other than Photoshop, please refer to your  

application’s user manual. 

Macintosh
1. Close all open applications. 

2. Insert the Complete Collection CD. 

3. Open the CD and double-click on the Complete Collection Setup file. 

4. Choose the plug-in to install, and then specify whether to install the plug-in into either 
Adobe Photoshop or Apple Aperture. When the plug-in installer appears, click Next to begin 
installation. 

5. After reading the Read Me and accepting the License Agreement, the installer attempts to 
install into the appropriate location. When installing into Photoshop or Photoshop Elements, 
check the installation path to ensure the installer located the appropriate folder. The appro-
priate location for Adobe Photoshop CS3 is: 

Macintosh HD : Applications : Adobe Photoshop CS3 : Plug-Ins*

6. When installing into Photoshop, specify whether the Nik Selective Tool launches automati-
cally when you start Photoshop. Please see the User Guide for the selected plug-in for more 
information. 

7. When the installation is complete, click the Finish button to close the installer and return 
to the Complete Collection installer. 

Accessing The Plug-Ins

Accessing the Plug-Ins in Photoshop or Photoshop Elements

1. Launch Photoshop, Photoshop Elements, or your image editing application.

2. Open an image. 

3. Click on the Filters menu and roll over Nik Software. A popup menu appears. Choose the 

plug-in to enhance your image. 

Tip: To access the Nik Selective Tool, navigate to the File > Automate or File > Automation Tools 

menu and select Nik Selective Tool.

Accessing the Plug-Ins in Aperture

1. Launch Aperture. 

2. Highlight the image(s) you wish to enhance with a plug-in. 

3. Click the Images menu and roll over Edit With. A popup menu appears. Choose the plug-in 

to enhance your image. 
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Workflow

Dfine 2.0

Reduce noise from your image 

while maintaining sharp detail 

using the U Point powered Con-

trol Points to selectively reduce 

contrast noise and color noise.

Viveza

Selectively control the color and light of 

objects and areas in your image to cor-

rect color and create more colorful and 

dynamic images.

Apply Noise Reduction 
with Dfine 2.0

Control Color and 
Light with Viveza 

Workflow

Color Efex Pro 3.0

Apply color correction, 

retouching, traditional filters, 

and creative enhancements 

with the 52 filters of Color 

Efex Pro 3.0. 

Silver Efex Pro

Convert your images into 

powerful black and white im-

ages with the most powerful 

and complete conversion tool, 

Silver Efex Pro. 

Sharpener Pro 3.0

Sharpen your images for any 

output device, without the 

guesswork and costly test 

prints normally associated 

with image sharpening.

Apply Enhancements 
with Color Efex Pro 3.0

Convert to black and white 
with Silver Efex Pro

Apply Output Sharpening         
with Sharpener Pro 3.0



Contrast Noise

Automatic Method

Measurement Rectangles

Color Noise
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Step 1: Measure Noise

What’s New in Dfine 2.0

Dfine 2.0 is the most powerful noise reduction application available to photographers. It 

installs as a plug-in to Adobe® Photoshop® or Apple® Aperture™ (or other image editing ap-

plications that conform to the Adobe Photoshop Plug-In Standard).

Dfine 2.0 features a new, resizable user interface, an improved noise reduction engine, and 

makes possible an improved workflow, letting you work faster and achieve higher qual-

ity results than ever before. Nik Software’s U Point® technology, already recognized as an 

enormously powerful tool for professional photographers, is now a component of Dfine 2.0. 

In short, Dfine 2.0 offers you, the photographer, the best in digital noise reduction.

Quick Start Guide

The first step in reducing noise within Dfine 2.0 is to 

measure the noise present in your image. This process 

enables Dfine 2.0 to determine the characteristics of noise 

based on the details found within the current image or 

within a previously saved profile to ensure the optimal 

level of noise reduction is applied.

Automatic

The Automatic method allows Dfine 2.0 to determine 

where the noise structures exist for the current image. The 

Automatic process was designed to work for the majority 

of the images, and it is recommended that you first start 

with the Automatic method. Click on the Measure button to 

profile the current image.

Manual

The Manual method enables you to draw Measurement 

Rectangles on your image to instruct Dfine 2.0 the 

characteristics of the noise that exists within that  

particular image.

Click on the Add Measurement Rectangle button, and then 

click and drag on an area within the image. You should add a Measurement Rectangle only 

on an area of the image where there was not detail in the original scene. Some recommended 

image detail to place Measurement Rectangles on are: 

	 - Sky

	 - Featureless walls

	 - Other smooth, detail less surfaces

After placing a Measurement Rectangle on the image, click on the Measure button to create a 

profile for the current image.

Dfine 2.0



Control Points

Color Ranges

Additional Controls
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Dfine 2.0 WorkflowStep 2: Reduce Noise

Once you have measured the noise inherent to your image, 

it is time to start reducing noise. You can choose from one 

of two methods to reduce noise globally or selectively, 

based on colors or objects found within your image.

Control Points

The first method of applying noise reduction within Dfine 

2.0, Control Points, is based on U Point technology. Each 

Control Point can control the amount of Contrast and Color 

noise reduction to apply to the object that it has selected. 

In this manner, you can quickly add Control Points and then 

indicate whether or not to apply Contrast or Color noise 

reduction to each object, and how much to apply.

You can also control the amount of noise reduction applied 

to the entire image using the global Contrast and Color 

noise reduction sliders in the Control Points method 

Color Ranges

The second method of reducing noise within Dfine 2.0 is 

based on individual Color Ranges. This method is most 

effective when affecting large objects or if you want to 

uniformly reduce noise based on color. 

Additional Controls Available for Each Reduction Method

Edge Preservation 

This control lets you balance detail and noise reduction. 

JPEG Artifact Reduction 

This control reduces JPEG artifacts in the active image. (Use only on JPEG files.)

Debanding 

The debanding control reduces banding artifacts, which appear as bands across an image.

Dfine 2.0 Noise Reduction Workflow

Select Dfine 2.0 from the Filter menu or the Selective Tool.

	 1. �Measure the noise in the image with the different measuring methods.

	 2. �Reduce noise using U Point powered Control Points, to selectively control 

the noise reduction if desired.

	 3. �Review the image in the Loupe.

	 4. �Apply the filter.

4

3

2

1

User Interface in Adobe® Photoshop® © 2008 David Beckstead



Select an area to 
enhance

Pixel Characteristic 
are analyzed

Information is 
processed through 
Central Blending 
Function

Image adjustment 
can be made with 
Control Points

Perfectly enhanced image

Dfine 2.0 Viveza Color Efex Pro 3.012 Dfine 2.0 Viveza Color Efex Pro 3.0 Silver Efex Pro Sharpener Pro 3.0 13Silver Efex Pro Sharpener Pro 3.0

Color Control PointsViveza

Welcome to Viveza

Welcome to Nik Software Viveza, the most powerful and precise tool for control over light and 

color in your photography. Viveza offers for the first time the ability for you to make correc-

tions and enhancements to specific areas on your photographs without the need for complex 

selections and layer masks. The power of Viveza comes from Nik Software’s patented U 

Point® technology.

Viveza will change the way you edit your pictures. You’ll work faster, more efficiently and be 

able to effectively pre-visualize your post-capture editing steps more clearly. Simply put, 

editing with Viveza will revolutionize the way you edit your pictures and allow you to achieve 

enhancements that were too complex or simply not possible before.

Quick Start Guide

Color Control Point Controls 

Size Slider

The Size slider affects the reach of the Color Control Point. 
By increasing this slider, you can affect objects similar to 
the object that the Color Control Point has been placed 
upon but that are further away from the Color Control Point. 

Decreasing this slider will make the 
Color Control Point affect only similar 
objects closer to the Color Control 
Point. 

Brightness, Contrast, Saturation, Hue, 
Red, Green, Blue, and Warmth Sliders

Each Color Control Point displays a 
Size slider along with either the BCS or All slider groups. The BCS slider 

group is the default slider group provided for a Color Control Point and contains the Bright-
ness, Contrast and Saturation sliders. The All slider group contains the entire range of sliders 
within Viveza. 

BCS/All Triangle

Each Color Control Point has a BCS/All triangle which when clicked will change the available 
sliders from BCS to All or All to BCS.

U Point® Technology
U Point technology lets you use Control Points to isolate objects and areas in an image and 
selectively apply light and color effects to your images. With U Point powered Control Points, 
there is no need to create complex selections or masks. For more information, visit www.
upoint.com.

© 2008 Ed Pierce



Control Point List

Details
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Viveza WorkflowControl Point List & Details

For best results in Viveza, perform the tasks below in the given order: 

1. �Add a Color Control Point to the image to adjust the first, most obvious 

issue within the image.

2. �Add additional Color Control Points to the other objects that you would like 

to control.

3. �To prevent any changes from affecting some object or area, add a Color 

Control Point with neutral settings. That is, add a Color Control Point to the 

object that you’d like to protect and ensure that each slider apart from the 

Size slider is set to 0.

4. Review the image in the Loupe.

5. Apply the filter’s effect by clicking OK.

Add Color Control Point 

Click this button to add a Color Control Point. The mouse 

pointer changes indicating that you can place a Color 

Control Point on the image. After placing the Color Control 

Point on the image, you may control the image’s color 

and light using the controls provided on the Color Control 

Point.

Control Point List  

The Control Point List shows all of the Color Control Points 

applied to the image. The Control Point List section pro-

vides you with basic information about each Color Control 

Point, and options to show the selections and previews of 

the Color Control Points. 

Details

The Details section provides you with information about 

the Color Control Points added to your image. Within the 

Details section, you can review each slider value or click 

on the value and type in a new value directly. 

If multiple Color Control Points are selected, you can adjust the controls of  

all the selected Control Points at once.

Below the Details are Duplicate and Delete buttons for an efficient workflow. 

Smart Filter Capability (Adobe Photoshop CS3 Only)

Viveza can be applied as a Smart Filter within Adobe Photoshop CS3. Smart Filters  

allow you to adjust or remove the filter’s effect in a non-destructive way. When Viveza  

is applied as a Smart Filter, you will be able to access and adjust the filter’s settings  

at any point in the future.

4

3

2

1

User Interface in Adobe® Photoshop® © 2008 David Beckstead
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Filter Display ModesColor Efex Pro 3.0

Quick Start Guide

What’s New in Color Efex Pro™ 3.0

Color Efex Pro 3.0 is the most advanced set of photographic filters for Adobe® Photoshop®, 

Apple® Aperture™ and Capture NX 2. It installs as a plug-in to Adobe Photoshop, Apple Aper-

ture, and Capture NX 2.

Featuring U Point-powered selection control points, nine new powerful filters, a new  

resizable interface in Adobe Photoshop and Apple Aperture, Smart Filter compatibility for 

Adobe Photoshop, multi-image editing for Apple Aperture, and tight integration with the  

non-destructive workflow of Capture NX 2, Color Efex Pro 3.0 is the most powerful set of  

digital photographic filters. 

For information about Color Efex Pro 3.0 for Capture NX 2, please see pages 6 and 7.

Color Efex Pro 3.0 offers two Filter Display Modes: Image 

Only and Image & Filter List. Click on the Image & Filter 

List button to display the Filter List, which provides 

access to the filters available within Color Efex Pro 3.0. 

Additionally, Filter Category Tabs are available, providing 

recommendations for certain filters specific to a photo-

graphic style.

Image Only

Click this button to show only the Image Preview with the 

current filter controls. 

Image & Filter List

Click this button to open a new palette displaying the 

names of available filters next to the Image Preview area. 

Filter Category Tabs

The filters in Color Efex Pro 3.0 are organized by 

category for easy experimentation, with each 

category corresponding to a tab in the Filter List. 

Filter Category Tabs organize dozens of filters and 

variations into a manageable workspace.

The Favorites tab is user-definable, containing only 

filters you add. All other tabs are pre-defined. Six 

tabs will be displayed, with the All and Favorites tabs always present. The remaining four 

tabs can be selected from within the Filter Settings.

The available tabs are:

All, Stylizing, Traditional, Landscape, Portrait, Wedding, Nature, and Artistic Tabs, 
which contain filters suggested for each style of photography.

Favorites Tab - Filters you add using the Filter List or the Selective Tool.  
You can add up to a maximum of 16 filters to the Favorites tab.

Image Only

Image & Filter List

Filter List Controls

Click on a tab to explore new filters.

Click on the name of a filter to update 

the image in the Image Preview and the 

filter control sliders and settings.

Click the star next to a filter’s name to 

add the filter to your Favorites tab for 

easy access.
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Color Efex Pro 3.0 WorkflowControl Points

U Point® Technology 

U Point technology lets you use control points to isolate 

objects and areas in an image and selectively apply filter 

effects to them. (For more, visit  www.upoint.com)

Each control point has two sliders:

• The top slider, Size, adjusts the Control Point’s size or 

reach. 

• The bottom slider, Opacity, controls the amount of filter-

ing applied to the area specified by the Size parameter. At 

100%, the filter’s full effect is applied; at 0%, the object or 

area retains its original colors and details.

The following controls apply to all filters:

Add 0% Control Point

Click this button to add control point preset to no filter 

effect. The mouse pointer changes, prompting you to place 

a control point on the image. After placing the control point 

on the image, you can adjust the Opacity slider.

Add 100% Control Point

Click this button to add a control point preset to the filter’s 

full effect. The mouse pointer changes, prompting you to 

place a control point on the image. After placing the control point, you can adjust the filter’s 

effect with the Opacity slider.

If the first control point added is a 100% control point, the Apply to entire image slider auto-

matically goes to 0%, ensuring that the filter is applied only to the control point. You can then 

adjust the slider manually.

Control Point Controls

U Point Technology Start with characteristics that affect the entire image, such as color casts, contrast, and tones. 

Next, modify elements that affect only localized areas, such as blemishes and small distract-

ing objects. Finally, apply effects that add a style or mood to the image. In other words, move 

from the general to the specific.

For best results, perform the tasks below in the given order:  

1. Select the filter to apply to the image from the Filter List.

2. Adjust the filter controls.

3. Protect Shadows & Highlights, if necessary.

4. Use U Point-powered Control Points, if desired.

5. Review the image in the Loupe.

6. Apply the filter.

5
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3
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1

Adobe® Photoshop® Interface © 2007 Roger Daines
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Selective Application of FiltersColor Efex Pro 3.0 for Capture NX 2

Windows

1. �Close all open applications. 

2. �Insert the Color Efex Pro 3.0 CD.

3. �When the auto-run installer appears, 

click Next to begin installing Color Efex 

Pro 3.0.

4. �Next, read the Read Me and accept the 

License Agreement.

5. �When the installer is complete, click the 

Finish button to close the installer.

Macintosh

1. �Close all open applications.

2. �Insert the Color Efex Pro 3.0 CD.

3. �Open the CD and double-click the Color 

Efex Pro 3.0 Setup file. When the Color 

Efex pro 3.0 installer appears, click Next 

to begin installation. 

4. �Next, read the Read Me and accept the 

License Agreement.

5. �When the installer is complete, click the 

Close button to close the installer.

Accessing Color Efex Pro 3.0 inside Capture NX 2

1. Launch Capture NX 2.

2. Open the image that you would like to enhance.

3. Navigate to the Filter menu.

4. �Roll over either the Color Efex Pro 3.0: Stylizing or Color Efex Pro 3.0: Traditional 
sub-menus

5. Select the filter you wish to apply to your image from this list.

Nik Software Color Efex Pro 3.0 for Capture NX 2 is the most advanced set of filters for digital 

photography. Color Efex Pro 3.0 filters are designed to make photographic enhancements  

not only easier, but better. Now the powerful filters of Color Efex Pro 3.0 are available  

for Capture NX 2.

Selectively Applying Color Efex Pro 3.0 Filters

All of the Color Efex Pro 3.0 filters can be applied 

selectively using the various selection tools found 

within Capture NX 2. A brief overview of the Selection 

Control Points, the Selection Brush, and the Selection 

Gradients can be found below. 

Selection Control Point   

Selection control points utilize U Point® technology to 

selectively apply the filter effect of the current step. 

You can use a selection control point to selectively 

apply any of the Color Efex Pro 3.0 filters. 

Selection Brush Tools   

The selection brush enables you to selectively paint-in or paint-out the filter effect in the cur-

rent step. You can use the selection brush to achieve an artistic application of the filters.

Selection Gradient Tools   

The selection gradient tools enable you to gradually blend between applying and removing 

the filter effect in the current step. There are two selection gradient tools to choose from, the 

Linear Gradient tool and the Radial Gradient tool.

Color Efex Pro 3.0 NEF Update Tool

 The Color Efex Pro 3.0 NEF Update Tool will convert any NEF files with Nik Color Efex Pro 2.0 

filters applied into the corresponding Color Efex Pro 3.0 filters with equivalent filter settings. 

For more information about updating NEF files with Nik Color Efex Pro 2.0 filters to Color Efex 

Pro 3.0 filters with the NEF Update Tool, please see the Color Efex Pro 3.0 for Capture NX 2 

User Guide.

© 2008 David Saffir

Installation for Capture NX 2
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Filter Display ModesSilver Efex Pro

Welcome to Silver Efex Pro™

Welcome to Silver Efex Pro, the most powerful tool for creating dynamic black and white im-

ages. Silver Efex Pro offers the traditional tools of the darkroom while utilizing the flexibility 

and precision offered with digital photography.

By combining unique algorithms, patented U Point® technology, and a full range of black and 

white specific tools, Silver Efex Pro provides the power and precision for creating stunning 

digital black and white photographs.

Quick Start Guide

Silver Efex Pro offers two Filter Display Modes: 

Image Only and Image + Style Browser. Click 

on the Image + Style Browser button to display 

the Style Browser, which provides access to 

the preset styles available within Silver Efex 

Pro. Silver Efex Pro comes with over 20 preset 

styles to help create powerful, dynamic black 

and white images quickly and easily, and you 

can create your own styles for easily repeated 

high quality results.

Image Only

Click this button to show only the Image Preview. 

Image + Style Browser

Click this button to open a new palette next to the preview area displaying a view of 

the available styles, with each style applied  

to a thumbnail of the current image.

© 2008 Suzette Allen

Style Browser Controls
• Click on a style to change your image’s look with one click.

• Click on the Add Style button to create a custom style based on the 
current settings.

• Click on the Delete button to remove the selected custom style. 

• Click on the Export button to save the selected custom style and 
share it with friends.

• Click on the Update button to update the settings of the custom 
style. 

• Quickly change the name of a custom style by double-clicking on 
the name and entering a new name.

• Click the star next to the style’s name to add the style to the favor-
ites tab for quick access.

• Click on the Import button to add a style from your hard disk.
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Silver Efex Pro WorkflowControl Points

The Power of U Point® Technology

U Point technology lets you use control points to isolate objects and areas in an image 

and selectively apply filter effects to them.  Visit www.upoint.com to learn more.

Add Control Point

Click this button to change the mouse cursor and enable you to add a control 

point to the image. After selecting this button, click on the object or area in the 

image to adjust using a control point. After placing the control point on the image, you 

may control the object or area’s tonality, contrast, and structure using the controls 

provided on the control point.

Control Point Controls 

Each control point has four sliders:

- �The top slider, Size, adjusts the control point’s 

size or reach.

- �The second slider, Brightness, controls the 

brightness of the object selected by the control point.

- �The third slider, Contrast, controls the contrast of the object selected by 

the control point.

- �The fourth slider, Structure, controls the detail structure of the object 

selected by the control point.

For best results, perform the tasks below in the given order:  

1. �Explore the Style Browser and if you like, choose a style to apply to your image. 

2. �Adjust the overall image with the Brightness, Contrast, and Structure tonality controls.

3. �Add control points to objects in the image that you would like to selectively control bright-

ness, contrast, and structure.

4. �Select a color filter to adjust the base tonal conversion and contrast.

5. �Explore and apply a film type preset if desired.

6. �Browse and apply a stylization to your image if desired.

7. �Review the image in the Loupe.

8. �Apply the filter’s effect by clicking OK (Photoshop) or Save (Aperture).

1
2

3

4
5
6

7

8
Adobe® Photoshop® Interface © 2008 Josh Haftel
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Sharpening PhotographsSharpener Pro 3.0

Welcome to Sharpener Pro 3.0

Welcome to Nik Software Sharpener Pro 3.0, the most advanced and powerful sharpening 

solution for photographers. Sharpener Pro 3.0 eliminates the guesswork typically required for 

achieving superior printed results while providing the most control possible.

Sharpener Pro 3.0 is a new generation of digital sharpening tools for photographers, featur-

ing on-image editing with U Point® powered control points, creative sharpening tools, as well 

as the most advanced algorithms designed specifically for sharpening digital photographs.

Quick Start Guide

© 2008 David Sanders

Nik Software Sharpener Pro 3.0 is designed to provide the 

most advanced and intuitive sharpening solutions for digital 

photographs. Sharpener Pro 3.0 offers two filters to enhance 

and sharpen your images quickly, easily, and with high qual-

ity, repeatable results: the RAW Presharpener filter and the 

Output Sharpener filter.

RAW Presharpener
RAW presharpening is the first step of a two-step sharpening 

process that some photographers have found can provide 

better quality in some images than a typical single-step 

sharpening process. When working in a two-step sharpening 

process, some small amount of sharpening is applied im-

mediately after converting a RAW file, while a second, more 

aggressive amount of sharpening is applied directly before 

output. If you plan to utilize only a single sharpening step, only apply the  

Output Sharpener to your images.

The RAW Presharpener filter should be used immediately after processing a RAW file and 

after any noise reduction has been applied. When using the RAW Presharpener filter, ensure 

that sharpening has been turned off in your RAW conversion tool.

Output Sharpener
The Sharpener Pro 3.0 Output Sharpener filter is designed to sharpen based on the loss of 

detail caused through different output methods, eliminating guesswork normally associated 

with sharpening for output. The highest quality sharpening and the power to selectively apply 

the sharpening with the use of U Point powered control points or color ranges make the Out-

put Sharpener filter the professional’s choice for sharpening their images for output.

In addition to the U Point powered control points, the Output Sharpener filter also offers new 

controls for creatively sharpening images to enhance fine details and textures. 

The Output Sharpener filter should be used as the very last step in the workflow, after any 

cropping or resizing. Use the Output Sharpener filter to prepare your file for the output device 

of your choice.
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Sharpener Pro 3.0 WorkflowControl Points

U Point® technology lets you use control points to isolate objects and areas in an image and 

selectively apply filter effects to them. (For more, visit www.upoint.com.)

Selection Control Points in RAW Presharpener

The U Point powered control points in the RAW Presharpener allow you to selectively apply 

or remove the sharpening effects from objects and areas in your photographs without any 

complicated selections or layers masks.

For more information about Selection Control Points in the RAW Presharpener filter, please 

see the Sharpener Pro 3.0 User Guide.

Sharpening Control Points in Output Sharpener

The U Point powered controls points in the Output Sharpener filter allow you to selectively 

apply the output sharpening and creative sharpening  

to objects and areas in your photograph without complicated selections or layer masks.

Add Control Point

Click this button to change the mouse cursor and enable you to add a control 

point to the image. After selecting this button, click on the object or area in 

the image to adjust using a control point. After placing the control point on the image, you 

may control the sharpening or apply creative sharpening to the object or area selected using 

the controls provided.

Sharpening Control Point Controls

Each sharpening control point has five sliders:

	 • �	The top slider, Size, adjusts the control point’s size or reach.

	 • �The second slider, Output Sharpening Strength, adjusts the strength of the output 

sharpening effect of the object or area.

	 •The Structure, Local Contrast, and Focus sliders will apply creative sharpening to the 

selected object or area.

Sharpener Pro 3.0 Sharpening Workflow

Select the filter to apply to the image from the Filter menu or the Selective Tool.

1. �Adjust the filter controls.

2. �Use U Point powered control points, to selectively apply or control the sharpening effect if 

desired.

3. �Review the image in the Loupe.

4. �Apply the filter.
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Contact and Support

United States

Contact Nik Software, Inc. by phone at (619) 725-3150  
Monday – Friday from 8:30AM – 5:00PM (PST) or via email at service@niksoftware.com

Nik Software, Inc.

7588 Metropolitan Drive

San Diego, CA 92108, USA

Phone (619) 725-3150

Fax (619) 725-3151

infous@niksoftware.com

www.niksoftware.com

Nik, U Point, Dfine, and Photography first are registered trademarks of Nik Software, Inc. 

Viveza, Color Efex Pro, Silver Efex Pro, and Sharpener Pro are trademarks of Nik Software, Inc. 

All other trade names mentioned in this manual are trademarks or registered trademarks of 

their respective holders.



To be eligible for free product updates,  

technical support and customer support  

please register online by visiting

www.niksoftware.com/register

Please have your product key available at  
the time you register


